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ABSTRACT

This User’s Guide for the International Space Station (ISS) Payload Data Library
(PDL) documents the information necessary for approved users to utilize the PDL application.
It provides an overview of the PDL architecture as well as system requirements for the
different platforms supported.  In addition, instructions are included for navigation through
the system, entering data, and generating output reports.
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SECTION 1, INTRODUCTION

1.1 SYSTEM OVERVIEW

The Payload Data Library (PDL) is an electronic database system developed to
support the Engineering and Operations Integration (E&OI) personnel in collecting and
managing payload data.  The primary function of PDL is to provide a convenient method for
collection, processing, managing, and distribution of payload information necessary for
payload complement integration and for preparation of integration requirements reports.  PDL
is configured as a  Web Enabled system utilizing Oracle software and is accessible to the user
via the Internet.  The user may obtain a user account and password, by accessing the PDL
Home Page on the World Wide Web (WWW) at http://pdl.hosc.msfc.nasa.gov.

Interfacing between PDL and other ISS databases is accomplished by using data file
transfers over various data networks as defined in the applicable Interface Control Document.

1.2 SYSTEM REQUIREMENTS

The PDL web client software is compatible with Internet Explorer 5, Netscape 4,
Windows ’95, Windows NT, and Mac workstations the level of a PowerPC and higher.  See
the sub-sections below for specific platform system requirements.

1.2.1 IBM-PC

A minimum system configuration to run this web client software on an IBM-PC
compatible computer is Windows 95, or Windows NT with an 80486 processor (266 MHz),
64 MB RAM, an 800 x 600 resolution color monitor with 16 colors, 10 MB of available disk
space, Internet Explorer 5 (strongly recommend), Netscape 4, and a 56 K modem
(recommend DSL or Cable Modem or Ethernet connection).  The PDL software operation
cannot be guaranteed if your system does not meet these minimum requirements.

1.2.2 Macintosh-PowerPC

A minimum system configuration to run this web client software on a Macintosh is a
PowerPC processor using Mac OS System 8.X, 64 MB RAM, an 800 x 600 resolution color
monitor, 10 MB of available disk space, Internet Explorer 5, and a 56 K modem (recommend
DSL or Cable Modem or Ethernet connection).  NOTE:  Netscape can’t be used on the Mac
because of problems with setting up the Java plug-in.  The PDL software operation cannot be
guaranteed if your system does not meet these minimum requirements.

1.2.3 Plug-Ins
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The following plug-ins are required to run the web-client software:

a. J-Initiator – Internet Java applets for PC Users

b. MacOS Runtime for Java (MRJ) – Internet Java applets for Mac Users

c. Adobe Acrobat Reader – For displaying documents in PDF format

d. Decompression Software (i.e., STUFF-IT EXPANDER) - For decompressing files
in G-ZIP format

1.3 WEB ENABLED TECHNOLOGY USED IN PDL

The PDL database uses  Web Enabled technology to implement a user-friendly, quick-
response data collection and management system.  Figure 1-1 depicts the PDL  Web Enabled
configuration.

   

PDL WEB 
APPLICATION 
• Internet Explorer 
• Netscape 

 

Users reaching PDL across the Web 

INTERNET 

PDL   
Oracle   

Database   

PDL Database Server 
Sun Enterprise 4500 

PDL Web Server 
Gateway 8400 NTS  

SQL*Net 
TCP/IP PC 

Mac 
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FIGURE 1-1  WEB ENABLED TECHNOLOGY IN THE PDL

Although a detailed understanding of this technology is not necessary to use the PDL,
you may find the following information useful.

The web server for the PDL system is a Gateway 8400 NTS and the database server
portion of the PDL system is a Sun Enterprise 4500.  Both machines are located at the
Marshall Space Flight Center (MSFC) in Huntsville, Alabama.  The Oracle Relational
Database Management System (RDBMS) runs on this server and will be kept up to date with
the latest version of the database.  The data that you enter into the PDL will be stored,
managed, distributed, and archived on this server.  Daily-automated backups ensure that your
data is not lost as the result of any anomaly in server operations.

The PDL web client system is an application that is launched from the PDL Home
Page on the web.  After entering your user ID and password, your computer is then connected
to the PDL server.  The web client application will allow you to retrieve and update data
stored on the server.  To ensure that the latest data is available to all users, no data is stored
on your local computer.

1.4 USER REQUIREMENTS

The PDL web client application utilizes a Graphical User Interface (GUI) to provide
an easy and consistent means of manipulating data; however, an understanding of the
following functions associated with a GUI is required:

A. Using system browsers for navigation.

B. Using a mouse and a pull-down menu.

C. Using a Navigation Tree.
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SECTION 2, GUIDELINES

2.1 PAYLOAD BREAKDOWN COMPONENTS

All data collected within the PDL is divided into data sets for easy navigation.  These
data sets are currently defined as Integration Agreement, ICD/PVP, CDH, Configuration,
EVA, EVR, Grnd Data Srvcs, KSC Support, KSC Technical, Operations, and Training.
Figure 2-1 depicts an example of the payload data set breakdown components.

 
Payload 

Manifest And Stowage 
EXPRESS CDS Contracts 

Data Set 

Options 

Forms 

ICD/PVP 
CDH 
Configuration 

EVA 
EVR 
Grnd Data Srvcs 
Etc. 

Drawings/Sketches/ECL 
Logistics 
Etc. 

Major Items (Installed tems) 
Stowed Items (Soft Mounted) 

FIGURE 2-1  PAYLOAD BREAKDOWN COMPONENTS

2.2 PAYLOAD IDS

The PDL uses the parameter format specified by the User Mission Database (UMDB)
for payload identification number definition.  The UMDB parameter format is:

AAnnn.mmB

AA- This is the two letter code that represents the payload owner.  The first digit
specifically represents the partner (N = NASA, J = NASDA, E = ESA, C = CSA), and
the second digit specifically represents the organization (C = Commercial, for
example).  So ESA, Commercial organization, would be EC for the first two digits.
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nnn- This is a three digit number, generated automatically by the UMDB, which
represents the ‘nth’ payload of this type.  So the first payload of type EC would be
EC001; the second would be EC002, etc.

mm- This is a two digit number, generated automatically by the UMDB, which
represents a subpayload.  The first time a payload record is created, this number is 00.
If another subpayload is created in the UMDB, then a new payload record is created
with the same payload ID, but this number is incremented by one to 01.  The next
subpayload created in the UMDB will be 02.

B- This one digit character can be one of the following:  “A” for attached payloads or
“P” for pressurized payloads.  This character is automatically assigned when the
payload is created as an attached or pressurized payload.

2.3 DATA DISTRIBUTION

There are several end users that utilize payload information collected in the PDL.
These end users will receive information via database exports or File Transfer Protocols
(FTP).  An Interface Control Document (ICD) between PDL and the end users will specify
the format of the data to be transferred and the method of transfer.  The following documents
define the planned interfaces with the PDL:

A. SSP 50189A - Interface with the JSC User Mission Database and the JSC Tactical
Planning System.

B. D683-21415-1 - Interface with the MSFC Payload Software Integration and
Verification Database.

C. ICD-3-60056B - Interface with the MSFC Huntsville Operations Support Center
(HOSC) Command/Telemetry Database.

D. SSP 50298 - Interface with the JSC Vehicle Master Database.

E. Interface with the KSC Operations and Maintenance Requirements and Specifications
(Document number not currently assigned).

F. Interface with the ESA Columbus Payload Database (Interface not currently defined).

G. Interface with the National Space Development Agency of Japan (Interface not
currently defined).

H. Interface with the Russian Space Agency Database (Interface not currently defined).
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SECTION 3, USING THE PAYLOAD DATA LIBRARY

All figures included in this section are from the web client  application using the PC
and Internet Explorer 5.  Not every screen is documented in this section, only screens that
provides the overall functionality of PDL.

3.1 STARTING THE WEB CLIENT APPLICATION

Users who already possess a PDL account can run the web-based version of the PDL
client.  The PDL website can be accessed through the Internet at the address:
http://pdl.hosc.msfc.nasa.gov.  The web page is displayed as shown in Figure 3-1.  The left
side of the PDL web page contains a menu tree, which is always displayed when the PDL web
site is up.  Some menu items can be expanded to show additional choices.  Additional uses of
the PDL website are addressed in Section 4 of this document.

Once expanded the Web Client menu item displays the Getting Started, Run PC Web
App and Run Mac Web App options.  To launch the web client you must first download
Oracle's J-Initiator or Mac OS Runtime for Java (MRJ) plug-ins.  These Java plug-ins can be
found under the Software menu item on the menu tree.  The J-Initiator is a plug-in for either
Internet Explorer or Netscape Navigator for the PC, and MRJ is the plug-in for the Mac.
Once you have the plug-in, you can click on the Run PC Web App or Run Mac Web App
option to launch the web application depending on the platform you are on.

The plug-ins and the web client are discussed in more details in Sections 4.1.1 and
4.2.1, respectively.
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FIGURE 3-1  PDL WEB PAGE

3.2 LOGGING ON

After successfully launching the appropriate web client, the first screen asks you to log
on to the PDL server.  This screen, shown in Figure 3-2, consists of two fields (Username and
Password) and three buttons (Exit, Change Password, and Logon).  Clicking the Exit button
exits the PDL web application, while the Logon button attempts to log onto the PDL Server
using the Username and Password entered. You will also find the PDL Help Line telephone
number on this screen.
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FIGURE 3-2  LOGGING ON

The first time you access PDL, use the temporary password assigned upon account approval.
You must enter a new password within three logons. Your new password must not begin with
a number and should be alphanumeric not exceeding 30 characters.  You are required to
change your password every 60 days.  The system will display a reminder message 14 days
prior to your current password expiration.  To change or enter a new password, click the
Change Password button.  Figure 3-3 shows the logon screen in the change-password mode.
Two new fields (New Password and Verify New Password) and a new button (No Change)
appears.  If you decide not to change your password, click the No Change button to return to
the first Logon Screen.  Otherwise, enter your new password in both of these fields and click
the Logon button to change the password and connect to the PDL server.  Use the tab key or
the mouse to move the cursor from field to field on the screen.
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Each user is given access privileges to certain areas of PDL based upon their account
profile.  There are three different levels at which an account may be established.  They are
Private, Integrated, and Controlled.  The Private level is used by the Payload Developers to
initially enter data describing a payload.  For accounts at this level, all data sets, options, and
forms are enabled; however, a user is only granted write privileges for the disciplines indicated
in the user’s account profile.  At the Integrated level, only options that have been promoted
from the Private level will be enabled.  A user is only allowed to change, promote, and/or
demote discipline data as determined by the user’s account profile.  The controlled level is
used by Configuration Management personnel.  At this level, data can only be changed via a
directive approved by a data set controlling authority such as a Control Board or Panel.

FIGURE 3-3  CHANGING A PASSWORD
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3.3 SELECTING A PAYLOAD, FLIGHT, AND INCREMENT

Once you have successfully logged on to the PDL Server the PDL  Payload Selection
Screen, shown in Figure 3-4 appears and is easily recognized by the Payload Types (ALL,
EXPRESS, PRESSURIZED, WORF) radio button selections, the Payload , Increment, Flight,
and KSC Processing Type pop-list selections.  The KSC Processing Type is for KSC Support
Only. The Launch Date and Launch Minus From Today fields are automatically populated
based on the previous selection of the payload, increment, and/or flight.

FIGURE 3-4  PDL PAYLOAD SELECTION SCREEN

To select a payload, select the payload type (EXPRESS, PRESSURIZED, WORF) then
move the cursor to the Payload selection pop-list box.  Click and hold to expand the list.
When the ALL is selected, the Payload selection pop-list will display all of the available
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payloads.  Move the cursor to the desired payload and release.  When the new payload is
selected, the Payload ID, Payload Acronym, and Payload Sponsor fields are automatically
displayed below the Payload selection pop-list.  The Increment, Flight, and KSC Processing
Type can be selected in the same manner as described.  Once a payload and all other
applicable information (i.e., increment and flight) have been selected as shown in Figure 3-5,
click the OK button and you are ready to begin your selection of the Dataset, Option and
Form from the Navigation Tree.

FIGURE 3-5  PAYLOAD, INCREMENT, AND FLIGHT SELECTION

3.4 UNDERSTANDING THE MAIN MENU SYSTEM
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After successfully selecting a payload, flight and/or increment, the PDL web
application main menu bar is displayed at the top of the screen as in Figure 3-6.  The PDL
web application main menu bar consists of File, Edit, Help, and Window menus.  These menus
are discussed in the following sub-sections in greater detail.

FIGURE 3-6  PDL MAIN MENU SYSTEM

3.4.1 File Menu Selections
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The pull-down items under the File menu include Payload Criteria, User Profile,
Reports, My RTF Reports, My ASCII Reports, Address Book, Promote/Demote, and Quit as
shown in Figure 3-7A.  If a form is active and displayed then the File menu will display User
Profile, Rebuild Tree, Address Book, Print, and Quit as shown in Figure 3-7B.  These menu
selections are discussed in more detail in the following sub-sections.

FIGURE 3-7A  FILE MENU SELECTIONS
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FIGURE 3-7B  FILE MENU SELECTIONS  WITH AN ACTIVE FORM

3.4.1.1 Payload Criteria

The Payload Criteria menu selection item will redisplay the Payload Selection Screen as
shown in Figure 3-4.

3.4.1.2 User Profile

The User Profile menu selection item allows the User the ability to change their
profile.  The User’s Profile Screen as shown in Figure 3-8 will appear.  The screen displays
your access to payload and data set information.  This access is determined by the data you
provided in the account request form.  There are three sections on this screen. The User
Profile section displays your access to payload and data set information.  This access is
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determined by the data you provided in the account request form.  The PDL System Messages
section is used to send individualized messages to you from the PDL DBA. The What’s New
section displays information messages of general interest such as payloads and flights that
have been added to the PDL database.  At the bottom of the screen are two buttons, the Edit
Address Info button and the Continue button.  The Continue button will return to the
previous screen.

FIGURE 3-8  USER PROFILE SCREEN

When you click the Edit Address Info button, the Contacts Information Screen
appears with your current account information as shown in Figure 3-9.  If the data for your
account has changed, correct it and click the Save button.  To add a new contact, click the
New button and enter the new information.  After you are finished, click the Save button.  The
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information is stored for later reference.  You may use the Find button to locate another
contact.  When you click this button, the Address Book pop-up as shown in Figure 3-10
allows you to either select a contact from a list or enter a name in the Find box.  Use the “%”
symbol as a wildcard character.  Click the Find button to begin the search.  Click OK when
finished.  The contact information for the name selected is displayed.  After saving all changes,
click the Exit button to return to the previous screen .  To delete a record of information from
the Contacts Information click on the Delete button.  A message will be displayed to confirm
deletion.  The Clear button will remove all information within each field on the form.

FIGURE 3-9  CONTACTS INFORMATION SCREEN
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FIGURE 3-10  ADDRESS BOOK POP-UP

3.4.1.3 Rebuild Tree

The Rebuild Tree menu selection item will rebuild the Navigation Tree and update any
information pertaining to the dataset(s).  Refer to Section 3.5 below for discussions on the
Navigation Tree.

3.4.1.4 Reports

Reports may be generated in two ways within the PDL.  First, the user may select
Reports from the File menu (Note:  If a Form is active, dismiss the Form in order to see the
Reports menu selection item).  The Report Selection screen will appear as shown in Figure
3-11.  This method is generally used for generation of summarized reports.  Select the



D683-35473-01, Draft Revision
9/5/01

3-14

Payload, Dataset, and the specific Report to be generated.  Select the appropriate Increment,
Payload Operation Performance (POP), Flight, Sub-element, Sort (1st, 2nd, 3rd), Course,
Timeframe, and Location, if applicable.  The final selection is the Destination of the report.
The user may select one of the following: Previewer, ASCII Text (.txt) , or MS WORD (.rtf).
The Previewer destination will immediately open the Adobe Acrobat Reader application and
display the report.  The user may print or save the report to their local machine.  The ASCII
Text destination will save the report in ASCII format and store the report in My ASCII Report
accessible under the File Menu (See Section 3.4.1.6 for more details). Finally, the MS WORD
destination will save the report in RTF format and store the report in My RTF Report
accessible via the File Menu (See Section 3.4.1.5 for more details).  Both the ASCII and RTF
destinations will display a dialog box as shown in Figure 3-12 indicating the name of the
report and the hyperlink where it can be found.  After the selections are complete, click the
Run Report button to generate the report.  Use the Exit button to return to the previous
screen.

The second report generation method is detailed in Section 3.4.1.9.

FIGURE 3-11  REPORT SELECTION SCREEN
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FIGURE 3-12  REPORT DIALOG BOX

3.4.1.5 My RTF Reports

The My RTF Reports menu item allows the User to access their RTF formatted
reports generated through the Reports option described in Section 3.4.1.4 above.  These
reports can be downloaded from the web server to the User’s computer for easy access by
clicking on the appropriate file name as shown in Figure 3-13.
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FIGURE 3-13  REPORT FILES

3.4.1.6 My ASCII Reports

The My ASCII Reports menu item allows the User to access their ACSII formatted
reports generated via the Reports option described in Section 3.4.1.4 above.  These reports
can be downloaded from the web server to the User’s computer for easy access by clicking on
the appropriate file name similar to the format shown in Figure 3-13 but with a .txt extension.

3.4.1.7 Address Book

The Address Book is discussed in Section 3.4.1.2 above and is displayed in Figure 3-
10.
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3.4.1.8 Promote/Demote

The Promote/Demote menu item is a critical component in the PDL process.  It is used
to electronically exchange payload and integration data between the Payload Developers,
integrators, data set, and configuration management teams, therefore prior to promoting or
demoting, verify that all forms have been filled in and the data in all forms is accurate.

There are three major data control levels in this process:  Private, Integrated, and
Baselined.  Within the integrated level, there are four sub-levels.  These sub-levels are
submitted, preliminary, final, and draft.  These levels are used by the integration engineers and
data set managers during the review process to document the maturity of the data.

The Payload Developer can promote private data to the integrated-submitted level.
Once this activity has taken place, the PD can only review it but will not be able to change it.
Authorized personnel at the integration level have the ability to both promote and demote data
to all sub-levels of the integrated level and demote back to the private level.  The
configuration manager can promote integrated-draft data to the baseline level.  Once the data
has been baselined, it can no longer be promoted or demoted.

To access the Promote/Demote screen shown in Figure 3-14, select the
Promote/Demote from the File menu of the PDL Main Menu.



D683-35473-01, Draft Revision
9/5/01

3-18

FIGURE 3-14  PROMOTE/DEMOTE SCREEN

The top of the screen displays the name of the specific payload whose data is being
promoted/demoted.  To change the payload, use the Exit button to return to the PDL Main
Menu screen.  Select File then the Payload Criteria menu item and the Payload Selection
Screen as shown in Figure 3-4 will appear.  You then can select another payload from the
payload selection pop-list and re-select Promote/Demote from the File menu.  Once the
correct payload has been chosen, select a specific Dataset, Increment, and Flight from the
appropriate pop-lists on the Promote/Demote Screen.  Note:  If the option being
promoted/demoted is not increment or flight-specific these selections do not have to be made.
As a result of the selections, option titles are displayed.  Click in the Process check box to the
left of the option title(s) to select the options to be promoted/demoted.  Select the New Status
Level and click the Process button.  This process may take a few minutes.  When the process
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is finished, the data resides at the selected level and a list of the options that were processed is
displayed in the message box.

3.4.1.9 Print

From any form within the PDL the User may select Print under the File menu to
generate a report for that particular form if one exists or default to a screen capture/print of
the form and populated data.

3.4.1.10 Quit

The Quit menu selection item exits the PDL web application.

3.4.2 Edit Menu Selections

The Edit menu selections allow the user to perform functions such as Cut, Copy, Paste
and Edit as shown in Figure 3-15 when manipulating the fields on the form.

FIGURE 3-15  EDIT MENU SELECTIONS
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3.4.2.1 Cut

 The Cut menu selection item removes selected information (selected by highlighting
with the left mouse button) and places it into memory (Clipboard) for future use.

3.4.2.2 Copy

 The Copy menu selection item copies (but does not remove) selected information and
places it into memory (Clipboard).

3.4.2.3 Paste

 The Paste menu selection item inserts the Clipboard contents at the cursor position.

3.4.2.4 Edit

Selecting the Edit menu selection item while in a text enterable field will activate a text
editor as shown in Figure 3-16 that will allow the user to insert into and/or modify the text
field.
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FIGURE 3-16  TEXT EDITOR

3.4.3 Help Menu Selections

In addition to the Help button on the lower right corner of a form screen as you will
see discussed later in this document, the Help menu allows you to access help information, as
shown in Figure 3-17.  The selectable items under the Help menu include General, On Forms,
News, Problem Reports, and Blank Book.  These are discussed in more detail in the following
sub-sections.
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FIGURE 3-17  HELP MENU SELECTIONS

3.4.3.1 General

To access general help, select General from the Help menu.  Enter a keyword in the
text box and click the Find button.  A list of matching items displays in the first scroll box.
Items in the list contain the keyword in the title or in the help text.  Select an item from this
box and the associated option title, form title, field title, and help text will be displayed (See
Figure 3-18).  Click Exit when finished.
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FIGURE 3-18  VIEWING GENERAL HELP

3.4.3.2 On Forms

To access form-specific help, select On Forms from the Help menu.  All PDL options
are displayed.  Note:  This is not data set specific.  Selecting an option displays help for that
option and a list of forms for the selected option (see Figure 3-19).
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FIGURE 3-19  VIEWING OPTION-SPECIFIC HELP

If the user selects a form, the Option Help is replaced by Form Help.  See Figure 3-20.
Click Exit when finished.
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FIGURE 3-20  VIEWING FORM-SPECIFIC HELP

3.4.3.3 News

PDL News, shown in Figure 3-21, is available by selecting News from the Help menu.
The current PDL version number is displayed as well as informative messages from the PDL
development team.  Click the Exit button to close the News window.
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FIGURE 3-21 VIEWING PDL NEWS

3.4.3.4 Problem Reports

To send comments to the PDL Team, choose Problem Reports from the Help menu
(See Figure 3-22).  Your username, current date, current version number, computer platform,
current discipline title, current option title, current section title, and the next comment number
autofills.  Type a message, comment, question, or problem in the description of problem field
(this is the only field that the user can update).  Click the Save button to send the comment to
the PDL team.  The First and Last buttons will move the pointer to the first and last records in
the list respectively.  The Previous and Next buttons will move the pointer one record
backward or forward from the current record.  Clicking the Revert button will revert the data
to the last saved version.  The New button will allow the user the ability to add new problem
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reports into the system.  Exit button returns to the previous screen.  Use the comment number
to check the status of the PDL response to your comment.

FIGURE 3-22  PROBLEM REPORTS SCREEN

3.4.3.5 Blank Book

The applicable dataset section of the Blank Book can be viewed by selecting Blank
Book from the Help menu when on that dataset in the Navigation Tree (See Figure 3-23).   
Adobe Acrobat Reader will launch a PDF formatted version of the document.  The Blank
Books can also be viewed by clicking on the folder icon for a dataset via the Navigation Tree
(See Figure 3-25).
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FIGURE 3-23  VIEWING THE BLANK BOOKS

3.4.4 Window Menu Selections

The Window menu allows the user the ability to view more than one screen at the same
time when working with multiple screens by positioning the widows displayed as Cascade,
Tile Vertically, or Tile Horizontally.  It also displays the name of the active screens as shown
in Figure 3-24.

3.4.4.1 Cascade

The Cascade menu selection item allows the user to stack the windows one over
another.
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3.4.4.2 Tile Horizontally

The Tile Horizontally menu selection item allows the user to stretch each window the
full width of the screen and stacks them one on top of the other.

3.4.4.3 Tile Vertically

The Tile Vertically menu selection item stretches the windows vertically and arranges
them side-by-side across the screen.

FIGURE 3-24 WINDOW MENU SELECTIONS

3.5 UNDERSTANDING THE NAVIGATION TREE AND ICONS
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Figure 3-25 shows the icons that are used in the Navigation Tree and their meanings.

Icon Characteristics Definition

Dataset Level Icons

 Closed and Opened Yellow Folder Dataset

Red Triangle Under Construction

Option Level Icons

Closed and Opened Blue Folder w/ P
Option at Private Level

Closed and Opened Green Folder w/ C
Option at Controlled (Baselined) Level

Closed and Opened Orange Folder w/ I
Option at Integrated Level

Closed and Opened Yellow Folder w/
Question Mark (?)

Option with no Data (additional data required and a
window will pop up to enter it)

Yellow Padlock No Data at that Level to View

Form Level Icons

Scroll w/ Orange Pen Read/Write Capability on Form

Scroll w/ no Pen Read Only Capability on Form

Black Question Mark No Data (needs additional data at the option level)

Gray X Box This form is not applicable to the type of data you are
working on

FIGURE 3-25 NAVIGATION TREE ICONS
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3.5.1 Navigating Through Data Sets

Upon selecting a payload, the Navigation Tree is built as shown in Figure 3-26.   Navigating
through datasets in the Navigation Tree can simply be performed by clicking on the
appropriate data set with the folder icon as shown in Figure 3-25.  The Datasets are as
identified in Figure 2-1 (Payload Breakdown Components).

FIGURE 3-26   NAVIGATION TREE
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3.5.2 Navigating Through Options

An option is a logical grouping of data entry forms.  Navigating through Options in the
Navigation Tree can simply be performed by expanding the Dataset node by clicking on the
appropriate folder icons as shown in Figure 3-25 above and then selecting the appropriate
Option from the list. If a question mark appears in the folder icon, as shown in Figure 3-25
above, once selected another window will pop up for the User to supply additional
information.  The type of windows that will require additional information are for Payload
Sub-elements, POPs, etc.  The following sub-section describes how to define a payload sub-
element.

3.5.2.1 Defining a Payload Sub-element

If there are multiple sub-elements for the selected flight, the screen to select or create a
particular sub-element is displayed as shown in Figure 3-27.  To define a sub-element, click
the New button and enter the Payload Sub-element Description and Acronym.  When new
sub-element(s) have been entered, click the Save button.  To delete a sub-element, select it
and click the Delete button.  The Exit button returns the user to the main screen.  Once a sub-
element is created it is displayed in the list.  Upon selecting the recently created sub-element
or an existing sub-element click the OK button and the forms are available for selection.
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FIGURE 3-27   DEFINING A PAYLOAD SUB-ELEMENT

3.5.3 Navigating Through Forms

 Selecting a form in the Navigation Tree can simply be performed by clicking on the
appropriate form icon as shown in Figure 3-25 above.

3.6 UNDERSTANDING THE STATUS LINE ON A FORM

The status of the current PDL form is displayed at the top of the form (See Figure 3-
28).  The status includes the original author and creation date of the current record, the author
and date of the latest change, and the configuration control level for the data currently
displayed on the form.  The name of the form also appears at the top of each form below the
status line.



D683-35473-01, Draft Revision
9/5/01

3-34

FIGURE 3-28  UNDERSTANDING THE FORM STATUS LINE

3.7 UNDERSTANDING THE LAYOUT BUTTONS

All Form screens have buttons at the bottom of the screen, as shown in Figure 3-28.
Each button has its own unique function that is easily executed by a single click.  The buttons
from left to right are:

EXIT Exits the form and returns to the Navigation Tree.

NAVIGATOR Brings the Navigator Tree to the front of the form and allow the
user to navigate to the next form in the Forms menu list
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DELETE Deletes the record shown on screen. This button may be disabled
if not applicable.

REVERT Reverses any changes that have been made to the current form
since the last save.  This button will be disabled if not applicable.

SAVE Saves all changes made to the current form.  This button will be
disabled if not applicable.

NEW Adds new records for user input to the current form.  This button
will be disabled if not applicable.

HELP Invokes item-specific help for items on a form.

In the event a user has a read-only account, only the Exit, Navigator and Help buttons
are enabled at the bottom of all Forms screens.  The other buttons are not applicable in this
case because no write access has been granted.

3.8 ENTERING INFORMATION INTO THE PDL

There are several ways to enter information into PDL.  Any constraints on data length
or format are displayed in the Hint Line at the bottom of the screen.  After entering
information, click the Save button on the bottom of the screen to save changes.

  Enterable fields have a white background.  Enter values by placing the cursor in the
white entry field and typing the information, shown in Figure 3-29.  Read-only information
displays in gray non-enterable fields.  Select items in a list by clicking in a checkbox as shown
in Figure 3-30.
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FIGURE 3-29  ENTERING INFORMATION IN ENTERABLE FIELDS
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FIGURE 3-30  ENTERING INFORMATION VIA A CHECK BOX

3.9 FIELD-SPECIFIC HELP

To access field-specific help, place the cursor in the appropriate field on the form, then
click the Help button (See Figure 3-31).  The help for the selected field will be displayed.
Click Exit when finished.
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FIGURE 3-31  VIEWING FIELD-SPECIFIC HELP
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3.10 IMPORTING/VIEWING GRAPHICS

3.10.1 Pressurized Payloads

PDL provides the capability to import and view graphics for pressurized payloads.
Figure 3-32 below shows the screen used for importing and viewing graphics associated with
the electrical/power system.  Drawings can either be resident or non-resident (also referred to
as CAD).  If it is a non-resident image you will need to download the file to your computer.
The importing and viewing of non-resident and resident image formats are discussed in greater
detail in sections 3.10.1.1 and 3.10.1.2, respectively.

FIGURE 3-32  ELECTRICAL/POWER SYSTEM GRAPHICS SCREEN
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3.10.1.1 Importing and Viewing Non-Resident (CAD) Drawings

Figures 3-33 through 3-39 will demonstrate how to import and view a new non-
resident drawing (also referred to as CAD) in PDL titled “PDL Sample Drawing1”.

To import a new non-resident drawing, select the New button then proceed by
selecting the Type of Image from the pull-down menu, provide the Interface Location of
additional documentation and/or drawings/schematics, indicate if a drawing is for a Flight Up
or Down, and in the Unique Reqts field specify any special handling or configuration
requirements for the payload.  Fill in the Drawing or Part Number, Revision, Drawing or Part
Title, and Sheet Number fields.  Select the CAD format from the pull down menu as shown in
Figure 3-33 below.  Then click on the Drawing button.

FIGURE 3-33  IMPORTING A NEW NON-RESIDENT DRAWING
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Upon clicking the Drawing button, the Upload/Download Content Screen will appear
as shown in Figure 3-34.  To upload a non-resident file, click on the New button on this
screen.
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FIGURE 3-34  UPLOAD/DOWNLOAD CONTENT SCREEN
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Upon clicking the New button, the Non-Resident Image Upload Form shown in Figure
3-35 will appear.  Browse or enter the name of the file to upload and then click on Upload
Non-Resident Image button.  A separate window as shown in Figure 3-36 will appear
displaying a message indicating the image was uploaded successfully.

FIGURE 3-35  NON-RESIDENT IMAGE UPLOAD FORM
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FIGURE 3-36  IMAGE UPLOADED SUCCESSFULLY WINDOW

Close the Image Uploaded Successfully window to return back to the
Upload/Download Content screen.  Click on the Re-query button to display the new record
you have uploaded.  The Application, Platform, Upload Date, and File Name will be
automatically populated upon upload as shown in Figure 3-37 below. To view the contents of
the file click on the Download Content button.
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FIGURE 3-37  NEW RECORD DISPLAYED

Upon clicking on the Download Content button, the File Download window will
appear as shown in Figure 3-38.  You can either open this file from its current location or save
it to disk.  Saving the file to disk is recommended and is done by clicking on the radio button
and clicking on the OK button.  Once the destination for the saved file is provided another
window will appear indicating that the download is complete as shown in Figure 3-39.  To
close this window click on the Close button.  The file is saved in a zipped format at your
desired destination and will require a decompression software (i.e., Stuff-It Expander) to open
it.
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FIGURE 3-38  FILE DOWNLOAD WINDOW

FIGURE 3-39  DOWNLOAD COMPLETE WINDOW
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Once you return back to the Upload/Download Content Screen, as shown in Figure 3-
37 above, click on the Save button in order to save the imported image and its associated
data.  Click on the Return button to go back to the screen in Figure 3-33.

3.10.1.2 Importing and Viewing Resident Drawings

Figures 3-40 through 3-45 will demonstrate how to import and view a new resident
drawing in PDL titled “PDL Sample Drawing2”.

To import a new resident drawing, select the New button then proceed by selecting the
Type of Image from the pull-down menu, provide the Interface Location of additional
documentation and/or drawings/schematics, indicate if a drawing is for a Flight Up or Down,
and in the Unique Reqts field specify any special handling or configuration requirements for
the payload.  Fill in the Drawing or Part Number, Revision, Drawing or Part Title, and Sheet
Number fields.  Select the Resident format from the pull down menu as shown in Figure 3-40
below.   Then click on the Drawing button.
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FIGURE 3-40  IMPORTING A NEW RESIDENT DRAWING

Upon clicking the Drawing button, the Enter/View Images Screen will appear as
shown in Figure 3-41.  To upload a new resident image, click on the New button on this
screen.
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FIGURE 3-41  ENTER/VIEW IMAGES SCREEN

Upon clicking the New button, the Enter Image File Information window will appear
as shown in Figure 3-42.  Note: If the image does not exist on the Webserver, you must
upload the image before clicking the "Read Image File" button.
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FIGURE 3-42  ENTER IMAGE FILE INFORMATION WINDOW

To upload an image to the webserver click on the Upload to Webserver button and the
Upload Images to the PDL Webserver Screen will appear as in Figure 3-43.  You must
browse for the image(s) by clicking on the Browse button or enter the file name with the
correct path and then press the Upload button to send this image to the webserver.  Close this
screen and return to the previous window shown in Figure 3-42.
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FIGURE 3-43  UPLOAD IMAGES TO THE PDL WEBSERVER SCREEN

To import an image file, you must specify the File Type and File Name (exact file
name that was uploaded) then click the Read Image File button after entering the required file
information as shown in Figure 3-44.  Upon clicking the Read Image File button it will return
to the Enter/View Images Screen which will be populated with the newly imported image for
viewing as shown in Figure 3-45.  Click on the Save button in order to save the imported
image and its associated data.  Click on the Return button to go back to the screen in Figure
3-40.
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FIGURE 3-44  IMPORTING AN IMAGE FILE
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FIGURE 3-45 VIEWING THE IMPORTED IMAGE

3.10.2 EXPRESS Payloads

The only difference in importing and reviewing graphics between EXPRESS and
Pressurized is how the resident and non-resident selection is made.  Figure 3-46 shows a
sample screen for importing/viewing graphics associated with On-Orbit Configuration
Drawings.  To view an image already loaded in PDL, select the drawing from the list and click
the Image button. If it is a resident image it will appear but if it is a non-resident image it will
need to be downloaded the same as for pressurized payloads.
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FIGURE 3-46  ON-ORBIT CONFIGURATION DRAWINGS SCREEN

To import a new graphic for the sample screen in Figure 3-46, click the New button to
add the Drawing No., Drawing Title, No. of Sheets, and Drawing Revision Level.  If the
image is non-resident, check the Non-Resident box and follow the directions noted at the
bottom of the screen.  Upon clicking the Image button, the Upload/Download Content Screen
will appear as shown in Figure 3-34.  Importing the non-resident image into PDL is the same
as described in Section 3.10.1.1 for the Pressurized Payloads (see Figures 3-34 thru 3-39).

If the image is resident, do not check the Non-Resident box.  Upon clicking the Image
button, the Enter/View Images Screen will appear as shown in Figure 3-41.  Importing the
resident image into PDL is the same as described in Section 3.10.1.2 for the Pressurized
Payloads (see Figures 3-41 thru 3-45).
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Once all images have been loaded, return back to the screen shown in Figure 3-46 and
click on the Save button in order to save the imported image(s) and it’s associated data.  Click
on the Exit button when finished to exit this screen.
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SECTION 4,  USING THE PDL WEB SITE

The PDL web site was created to satisfy the need for  people access information about
PDL across the Internet.  A visitor without a PDL user account can view basic information
about PDL on pages such as the News and Frequently Asked Questions (FAQ).  The visitor
can also apply for a PDL users account through the Accounts web page.  Users who already
possess a PDL account can run the web-based version of the PDL client, and can upload and
download drawings files to the PDL server machine.  The PDL web site can be accessed
through the Internet at the address:  http://pdl.hosc.msfc.nasa.gov.

This section of the document describes the screens and functions available to visitors
and PDL users across the Internet.  All figures included in this section are from the PDL web
site as viewed using Internet Explorer 5 on a PC.  If you access the PDL web site through a
Netscape browser or on a Mac, what you see may be different from the pictures in this
document.

4.1 PUBLIC PAGES

The PDL web site is divided into two groups of pages: those which can be viewed  by
all visitors and those which require a PDL user account to access.  Pages which can be
reached without a PDL user account are called “public” pages because they can be viewed by
any Internet user.

The left side of the PDL web page contains a menu tree which is always displayed
when the PDL web site is up.  Some menu items can be expanded to show additional choices.
The menu provides a quick way to jump to a particular PDL page of interest.  Figure 4-1
shows an example of the basic navigation menu from the left frame on the PDL page.
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FIGURE 4-1  LEFT NAVIGATION MENU

4.1.1 Software Pages

The Software pages contains the plug-ins necessary to successfully run the PDL web-
client as described in Section 4.2.1. These plug-ins are described in the following sub-sections
and should be installed on the user’s local computer.

4.1.1.1 Java Plug-ins

In order to run the PDL web client, it is necessary for the user’s local machine be able
to support the running of Java applets across the Internet.  Figure 4-2 shows the page where
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you can download the Oracle Jinitiator for the PC or the MacOS Runtime for Java (MRJ) for
the Mac.  If the user has a PC, click on the Download the Oracle JInitiator 1.1.8.10 plug-In
link to download the latest Oracle Jinitiator plug-in and save the executable file to the local
hard drive.  Do not try to open the file across the Internet.  When it has been saved to the
local hard drive, find the file and double-click to execute it.  The page also contains
instructions for how to install the software.  Some browser versions may not compatible with
the Jinitiator software.  Please update the local browser if necessary.

Notice:  For Windows 2000, do not install the plug-in under the "C:\Program Files"
directory (the default). Create a new directory (for example C:\Jinitiator) and install the
plug-in there. When the installer window shows you the suggested "Destination Directory",
click on the "Browse" button and type in or select the directory you created.

If the user has a Mac computer, select Download the Mac OS Runtime for Java (MRJ)
2.2 plug-in at the bottom of this page.  The user should follow the instructions on the page for
installation.  MRJ is configured to work with Oracle on the Mac the same way Jinitiator does
on the PC.

Notice:  If you have trouble uncompressing the MRJ or your Stuff-It program says the MRJ
file is corrupt, you will need to get a newer version of Stuff-It. You can download a new
Stuff-It Expander from this web site. On the left navigation menu under "Software", click on
"Stuff-It Plug-Ins." Scroll down to the Mac Stuff-It Expander. Install the new Stuff-It on your
Mac and then return here to finish downloading and installing MRJ.
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FIGURE 4-2 JAVA PLUG-INs PAGE

4.1.1.2 Adobe Plug-Ins

This page contains the link to the Adobe web site where you can download the latest
version of the Acrobat Reader to your machine for viewing reports generated by the PDL
Web Client as shown in Figure 4-3. This plug-in will allow your browser to automatically
pop-up a display of a report you have run.
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FIGURE 4-3 ADOBE ACROBAT READER PAGE

4.1.1.3 Stuff-It Plug-Ins

In order to view compressed drawings and graphics retrieved from the PDL database,
it will be necessary for you to download a browser plug-in for the Aladdin Stuff-It Expander
from the page as shown in Figure 4-4 . This plug-in will allow your browser to automatically
uncompress the drawing, diagram or picture as it is retrieved from the database.  PC users
should select Download the PC Stuff-It Expander plug-in and the Mac users should select
Download the Mac Stuff-It Expander plug-in.  The steps are provided for both installations.
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FIGURE 4-4 STUFF-IT PLUG-I ns PAGE

4.1.1.4 PC Instructions

The page shown in Figure 4-5 contains basic instructions for installing and running the
PDL Web Client on your PC.
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FIGURE 4-5 PC INSTALLATION INSTRUCTIONS PAGE

4.1.1.5 Mac Instructions

The page shown in Figure 4-6 contains basic instructions for installing and running the
PDL Web Client on your Mac.
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FIGURE 4-6 MAC INSTRUCTIONS PAGE

4.1.2 Data Set Contacts Pages

The Data Set Contacts pages are divided between contacts for Express payloads,
Pressurized payloads, and contacts for WORF payloads.  Contact information includes the
name of the data set, the name of the contact, and the contact’s phone number.  This
information is provided as a convenience for current PDL users and for potential PDL users
who need more information before requesting a PDL user account.  To reach the Data Set
Coordinators/Contacts pages, click on the left menu.  The Data Set Contacts selection will
expand to a selection of either Express payload contacts or Pressurized payload contacts.
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Clicking on one of those two menu choices will display the appropriate Data Set
Coordinators/Contacts page.

Figure 4-7 shows an example of a sample Data Set Coordinators/Contacts page for
Express payloads.  Notice the expanded left navigation menu and the selection of the Express
Contacts.  Because the contacts for payloads frequently change, you should always consult
the PDL web pages for the latest contact information.

FIGURE 4-7 DATA SET COORDINATORS PAGE

4.1.3 Accounts Request Pages
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The Account Request pages allow a non-PDL user to request a PDL user account.
There are three kinds of PDL accounts: Payload Developer, ISS Integrator, and International
Partner.  These are discussed in more detail in the following subsections.

4.1.3.1 Account Request – Payload Developer

The Payload Developer Account Request Form should be filled in by people who need
to use PDL to load payload development type data for payload integration.  Because of the
large number of possible payloads, the page is longer than can be displayed on a single screen.
Use the scroll bar on the right of the browser window to scroll down through all of the fields
on the page.  The following three figures combine to make up the Payload Developer Account
Request Form.

Figure 4-8 shows the top portion of the Payload Developer Account Request Form.
The user should select one or more payloads to which he/she is affiliated.  Click the box to the
left of the payload name to select it.  At least one payload must be selected.  Payloads are
divided between Express payloads and Pressurized payloads.  Payload names are alphabetical
within each grouping.

Note: the user may NOT select all payloads.  An error condition will occur.  The user
should select only those payloads to which he/she is affiliated.  The NASA appointed point of
contact for the selected payload(s) will be contacted for authorization prior to a PDL account
being issued to the user.
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FIGURE 4-8 PAYLOAD ACCOUNT REQUEST, PAYLOAD AFFILIATION

At the bottom of the list of selectable payloads is a field called “Other Payloads.”  If
the user’s payload does not appear on the page, the user should check the selection box to the
left of the label and type the name of the payload into the data entry field.  Figure 4-9 shows
the “Other Payloads” option at the end of the list of payloads.

Figure 4-9 also shows the next section of the Payload Developers Account Request
form, the selection of the user’s Dataset/Discipline.  If a user only requires Read-Only access
to the payload(s) selected above, click the “If Read-Only access required” box.  Otherwise,
the user should check one or more boxes corresponding to the user’s area of responsibility.

Note:  If access to all datasets/disciplines is requested, the user should check the “All
Disciplines” box.  The user should not select any other datasets because they are included in
the “All”.



D683-35473-01, Draft Revision
9/5/01

4-12

FIGURE 4-9  PAYLOAD ACCOUNT REQUEST, DATASET/DISCIPLINE

Figure 4-10 shows the fields which collect data about the user.  Fields which are
marked in bold text and by an asterisks (*) are required and must be filled in.
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FIGURE 4-10  PAYLOAD ACCOUNT REQUEST, USER INFORMATION

Notice that the address to be entered is the user’s business address.  The Internal Mail
Code field is required so it must be filled in.  If the user does not have a special code for mail
distribution, please enter “None” in this field.

  An email address is also required because PDL information messages and system
interruption warnings are sent via email.  The user is allowed to select an account ID.  This
makes it possible for the user to have the same ID for PDL as on their local computer
network, making it easier to remember.  In case that account ID has already been assigned to
another user, the user is encouraged to enter a second choice for an ID.  At the bottom of the
form, the user should select which computer platform they will be using.



D683-35473-01, Draft Revision
9/5/01

4-14

After all fields have been entered, the user should click on the Submit button to submit
the account request.  If a required field has been left blank, the user will see an error message
reporting which field must be filled in.  The user should use the Back key or arrow on their
browser to return to the account request page to correct the error.

If all fields have been filled and the account request successfully submitted, a page will
be displayed with the message: “Your Account Request has been submitted. You will be
contacted when it is approved.  Any questions?  Please call the PDL Helpline at (256) 961-
1265.”  The NASA approved payload coordinator(s) will be contacted for authorization prior
to a PDL account being issued to the user.

4.1.3.2 Account Request – ISS Integrator

The Integration Account Request Form should be filled in by people who need to use
PDL to perform ISS integration activities.  The following two figures combine to make up the
Integration Account Request Form.  The scroll bar on the right of the browser window can be
used to scroll down through all of the fields on the page.

Figure 4-11 shows the top portion of the Integration Account Request Form.  The
user should select one or more disciplines or datasets to which he/she is assigned.  Click the
box to the left of the dataset/discipline to select it.  If the user only needs Read-Only Access to
PDL, please check the Read-Only box on the right.  Otherwise, at least one dataset/discipline
must be selected.
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FIGURE 4-11  INTEGRATION ACCOUNT REQUEST, DATASET/DISCIPLINE

Figure 4-12 shows the fields which collect data about the user.  Fields which are
marked with bold text and by an asterisks (*) are required and must be filled in.
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FIGURE 4-12  INTEGRATION ACCOUNT REQUEST, USER INFORMATION

Notice that the address to be entered is the user’s business address.   The Internal Mail
Code field is required so it must be filled in.  If the user does not have a special code for mail
distribution, please enter “None” in this field.

  An email address is also required because PDL information messages and system
interruption warnings are sent via email.  The user is allowed to select an account ID.  This
makes it possible for the user to have the same ID for PDL as on their local computer
network, making it easier to remember.  In case that account ID has already been assigned to
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another user, the user is encouraged to enter a second choice for an ID.  At the bottom of the
form, the user should click on what kind of system they will be using.

After all fields have been entered, the user should click on the Submit button to submit
the account request.  If a required field has been left blank, the user will see an error message
reporting which field must be filled in.  The user should use the Back key or arrow on their
browser to return to the account request page to correct the error.

If all fields have been filled and the account request successfully submitted, a page will
be displayed with the message: “Your Account Request has been submitted. You will be
contacted when it is approved. Any questions? Please call the PDL Helpline at (256) 961-
1265.”  The NASA approved data set coordinator(s) will be contacted for authorization prior
to a PDL account being issued to the user.

4.1.3.3 Account Request – International Partners

The International Partner Account Request Form should be filled in by people located
in other countries who need to use PDL to perform payload or integration functions.
International Partners are covered under special agreements with NASA.  Therefore, all
requests by International Partners for PDL accounts must be approved by the ISS Payload
Office at Johnson Space Flight Center (JSC).  Please allow ample time for the account
approval cycle.

The following two figures combine to make up the International Partner Account
Request Form.  The scroll bar on the right of the browser window can be used to scroll down
through all of the fields on the page.

Figure 4-13 shows the top portion of the International Partner Account Request Form.
The data entry fields collect contact information about the user.  Fields which are marked in
bold text and by an asterisks (*) are required and must be filled in.



D683-35473-01, Draft Revision
9/5/01

4-18

FIGURE 4-13  INTERNATIONAL PARTNER ACCOUNT REQUEST, TOP

Notice that the address to be entered is the user’s business address.  Not all fields may
be needed for an international address.  If a field is required by the form but the user does not
have a value for it, please enter “N/A” (Not Applicable) in the field.

Figure 4-14 shows the remaining user informational fields.  The page is too large to be
displayed on a single screen.  Use the scroll bar on the right side of the browser window to
reach the lower fields.



D683-35473-01, Draft Revision
9/5/01

4-19

FIGURE 4-14  INTERNATIONAL PARTNER ACCOUNT REQUEST, BOTTOM

An email address is required because PDL information messages and system
interruption warnings are sent via email.  The user is allowed to select an account ID.  This
makes it possible for the user to have the same ID for PDL as on their local computer
network, making it easier to remember.  In case that account ID has already been assigned to
another user, the user is encouraged to enter a second choice for an ID.  At the bottom of the
form, the user should click on what kind of system they will be using to run the PDL client.

After all fields have been entered, the user should click on the SUBMIT button to
submit the account request.  If a required field has been left blank, the user will see an error
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message reporting which field must be filled in.  The user should use the Back key or arrow
on their browser to return to the account request page to correct the error.

If all fields have been filled and the account request successfully submitted, a page will
be displayed with the message: “Your Account Request has been submitted. You will be
contacted when it is approved. Any questions? Please call the PDL Helpline at (256) 961-
1265.”  The NASA Johnson Space Flight Center will be contacted for authorization prior to a
PDL account being issued to the international user.

4.1.4 Documentation Pages

The Documentation page on the left menu contains links to documentation such as the
PDL Users Guide, EIA Blank Book, Generic Payload Verification Plan, and PMIT Special
Topics which directly affect PDL functionality.   Figure 4-15 shows an example of a document
displayed directly in the right frame after being selected.

Be aware that larger documents can be slow to display in the right frame of the page.
The speed of delivery is dependent on the size of the document, the memory available on the
local machine, and the speed of the network connection and the Internet.  Please be patient
while the hour glass cursor is displayed.
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FIGURE 4-15  PDL DOCUMENTATION DISPLAY

Documents which have more than one revision may be moved to a separate page.
Figure 4-16 shows the PDL Users Documentation page that collects the various versions of
the PDL Users Guide, and a related IDD.  Click on the names of documents on this page to
display them.
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FIGURE 4-16  PDL USER DOCUMENTATION PAGE

Documents are usually available for display in PDF format, though some special
purpose documents may be in other formats such as PowerPoint.  The PDF format requires
the Adobe Acrobat Reader software.  To make this easier, the PDL User Documentation page
includes a graphic that has a link to take the user to the Adobe web page.  Once there, the
user should select the option to “Get Acrobat Reader” which is free.  Follow the Adobe
instructions for downloading and installing the Acrobat Reader software.

Some PC versions of Internet Explorer have difficulty displaying documents across the
Internet to the Adobe Acrobat Reader.  The symptom of this is the right frame of the browser
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paints white but no document or hourglass cursor is displayed within a reasonable amount of
time.  If this problem occurs, try downloading the document to your local machine.  To do
this, use the Back Arrow to return to the User Documentation page.  Position your cursor
over the name of the document and click the right mouse.  A menu will be displayed.  Select
“Save Target As..”  A Save As box will appear.  Pick a location on your local machine and
click the Save button.  The file will download.  Use the Adobe Acrobat Reader to open the
document file on your hard drive.

4.1.5 Frequently Asked Questions (FAQ) Page

The FAQ page provides a variety of general information about PDL to the casual
visitor and the potential PDL user.  Figure 4-17 shows an example of the top of the PDL FAQ
page.  The questions at the top of page highlighted in green are hyperlinks.  Click on a
question, and the page will jump down to the part of the page where the answer is displayed.
Alternately, the visitor can use the scroll bar on the right side of the page to scroll down
through all of the questions.  After each question is a hyperlink labeled “Back to Top” which
will move control back to the questions at the top of the FAQ page.
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FIGURE 4-17  FREQUENTLY ASKED QUESTIONS PAGE

4.1.6 PDL News Page

The PDL News page is the first page displayed to all visitors to the PDL web site.  It contains
information about the current version of the PDL software, information about how to set up a
Macintosh computer to access PDL, and other general information such as the phone number
for the PDL Helpline.  Figure 4-18 shows an example of the PDL News page.
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FIGURE 4-18  PDL NEWS PAGE

Not shown in this screen shot is the welcome message from the Ground System’s
Department manager which reads:

A Note from the MSFC Ground Systems Department Manager:

Ground Systems personnel are committed to meeting the needs of our customers.  Our
responsible contact personnel for specific products and services will work with you on a
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routine basis to achieve this commitment.  If this is not successful for you, feel free to contact
me directly.  Many thanks.

Ann McNair, Department Manager
email:  Ann.McNair@msfc.nasa.gov
Phone: 256-544-2025

4.1.7 Links Page

The Links page contains web page addresses for other ISS web pages which might be
of interest to the PDL user.  Figure 4-19 shows the graphic that is displayed when Links is
selected on the left menu.  The user can click on the acronym of another ISS-related group or
system to jump to their web page.  Most of the web pages referenced are public pages
viewable by all Internet users.  However, some of the links lead to web pages which require an
account to access.  If an account is required on another system, please contact the owner of
that page for information about gaining access to their web site.  Contact information is
usually available at the bottom of the page.
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FIGURE 4-19  WEB LINKS PAGE

4.2 PDL USER PAGES

The PDL web site contains many pages which can only be reached by a user who
already has a PDL user account.  When the user selects one of these private pages, a PDL
logon box will appear on top of the current window.  The user must enter a PDL user name
and password before the web page is displayed.  The paragraphs in this section of the
document describe the private web pages in PDL.

Figure 4-20 shows the logon box which is displayed when a user selects a private page
from the left menu.  If the user correctly enters a PDL user name and password combination
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and clicks OK, the requested web page will be displayed.  If the user does not enter the logon
information or if the information is not correct, the logon box will remain displayed.  After
three incorrect logon attempts or if the user clicks the CANCEL button, the logon box will
disappear and the following message will be displayed: “This document is protected. You must
send the proper authorization information to access it.”

The one exception to this logon scheme is when the user starts up the Web Client for
either the PC or the Mac.  In that case a new screen window is opened and the standard PDL
logon form is displayed.  See Figure 3-2 for an example of the PDL logon form.

                           

FIGURE 4-20  PDL WEB PAGE LOGON BOX

Notice the small check box below the password line.  Clicking on the check box will
save the user’s PDL user name and password to a browser file.  The next time the user comes
to a similar logon box, the user name and password will be filled in automatically.  This will
happen even if the user has shutdown and restarted the browser.  This feature also means that
your PDL user name and password will be filled in for any other user who uses your machine
and tries to access PDL through the web site.  PDL does not recommend saving your
password in this way.
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4.2.1 Web Client

The complete PDL web application can be run across the Internet from the PDL web
site.  This means that the PDL user does not have to have any PDL software on his/her local
machine.  Simply start a web browser and select either Run PC Web App or Run Mac Web
App, depending on the type of machine the user has.  A second window will be started in front
of the browser window.  This window will contain the logon for the PDL web client (see
Figure 3-2).  Once the user had logged on to PDL, the PDL application will run in the new
window.  The web client software is running on the PDL Web Server machine instead of on
the user’s local machine and requires the Internet connection to function.

Selecting Getting Started will give you instructions on getting started on your PC or
Mac, running the web client on your PC or Mac, minimum PC and Mac hardware
requirements, how to obtain a PDL account and a brief explanation of a what is a web client.

Here are some guidelines for running the PDL web client.  The web site starts the PDL
web-client in a separate window.  Each window that is displayed on the screen requires
machine memory.  If the PDL application seems slow, try closing other applications that may
also be running on the local machine.  This will free up machine resources.  If the window is
too small, part of a PDL form may not display.  If the right side of the screen is blank or gray,
it is likely that the window in which the PDL web-client is running is not large enough.  Click
the cursor on the lower right corner of the window and drag it larger. The window should
repaints itself with the full PDL form.  If only part of a form is displayed, it may be necessary
to first use the cursor to drag the window larger and next use the cursor to drag the form
within the window larger.

In order to run the PDL web client, it is necessary for the user’s local machine be able
to support the running of Java applets across the Internet.  If the user is having trouble
starting the PDL web client, it may be because Java cannot run.  PC users will need to install
the Oracle J-Initiator software and Mac users will need the MacOS Runtime for Java (MRJ).
Refer back to Section 4.1.1 on the how to install the necessary plug-ins.

4.2.2 PCI Drawings Page

The Payload Configuration Integration (PCI) Drawings pages allows an authorized
PDL user to retrieve non-resident PCI drawings files from the PDL Web Server machine to
his/her local disk drive for viewing.  NOTE:  All drawings and graphics will now be stored in
the PDL database so it will no longer be necessary to upload and download non-resident
drawings through the PDL web page.  The drawing download function is still available so
users can retrieve old drawings stored on the PDL web server machine.
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4.2.2.1 Old Download

Old drawings can be reached by selecting PCI Drawings and Old Download from the
left menu.  The PDL web logon box shown in Figure 4-20 will be displayed.  After the user
has successfully logged onto PDL, a screen for Payload Selection will be displayed.   Figure 4-
21 shows the screen used to pick the payload for the drawing files that will be displayed.

FIGURE 4-21 PCI DOWLOAD, PAYLOAD SELECTION
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The user will only be allowed to select a payload from a list of the payloads to which
he/she has access.  Use the pull-down list to pick the payload.  When the correct payload
appears in the payload field, click on the Submit button.

The drawing File Selection page will display any PCI drawings which are available for
download for this payload.  If no drawings have been uploaded, a blank list will be displayed.
Figure 4-22 shows a sample list of files displayed on the File Selection page.

FIGURE 4-22  PCI DOWNLOAD, FILE SELECTION PAGE
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To select a drawing for download, click on the name of the drawing.  Depending on
the operation system of the local computer, the user may be prompted to open the file or to
save the file to disk.  If this option is offered, always save the file to disk.  (Opening large files
across the Internet can be very time consuming.)  The user will be asked to select a location
for the file on the user’s local machine.  Select the location and click the Save button.

For a short file, the file download may appear to take no time at all.  For a long file, a
progress screen may be displayed.  How the user will be notified will vary according to the
local operating system and the type of browser.  After the transfer has been completed, check
the local disk to make certain the file has been saved and that its length is longer than zero
bytes.  Use the appropriate utility to open the new copy of the file (i.e. AutoCAD for a .dxf
file).

The most common error that can occur during the download process is that the file to
be downloaded is listed in the PDL database but does not exist on the Web Server machine.
This can happen when the drawing upload was unsuccessful but the user did not perform the
verification step.  Figure 4-23 shows an example of the error page which will be displayed
when the browser is Internet Explorer 5.



D683-35473-01, Draft Revision
9/5/01

4-34

FIGURE 4-23 PCI DOWNLOAD ERROR MESSAGE PAGE

Notice the HTTP 404 message toward the bottom of the error message page.  It
means  that the file requested from the Web Server machine cannot be found to download.
This error should be reported back to a contact for the payload so that the file can be re-
uploaded to PDL.

If the same error is displayed by a Netscape browser, the browser will return a blank
page with the message:  “The requested URL was not found.”  This has the same meaning as
the “File not found” in Figure 4-23.
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The Netscape error message may say: “The request has invalid syntax.”  This error
message means the name of the file, as saved in the PDL database, cannot be used to
download the file.  The file name may contain blanks or special characters.  It also means that
the drawing file was not successfully uploaded to the Web Server.  Try looking for a newer
version of the drawing in the PDL database drawings.

4.2.3 Report Request Page

The PDL Reports Request page can be used to request new reports for inclusion in
PDL. Figure 4-24 shows the top part of the Report Request Form.  Fields which must be filled
in are indicated by bold text and by an asterisks (*).
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FIGURE 4-24  PDL REPORT REQUEST, TOP

The top of the Report Request page asks for contact information about the user who is
submitting the request.  This will be used in the event for more information is needed for
development.

A Report Title can be entered.  Next, the user must then decide what categories of
users should have access to this report.  For scheduling purposes, the user is asked to
prioritize this report.  A date must be entered by which this report is needed.

The rest of the report requests information about what should be included in the report
and how it should be organized.  The user will be asked for the Data Set to which the report
pertains.  Enter the name of one of the data sets found on the Navigation Tree (see Figure 3-
26).  For the Option, enter one of the options available on the Navigation Tree after the data
set has been selected (see Figure 3-26).  In PDL when the user has selected a data set and an
option, a list of possible data entry screens becomes visible on the Navigation Tree (see Figure
3-26).  One or more of these forms contains the data that should appear in the report.  Enter
the name of the form(s) in the Forms(s) (Screen Title(s)) field on the Report Request Form.

Next the user will be asked to enter the data items which should appear in the report.
Use the name of the data item as it appears labeled on a PDL form.  You can enter a data item
field name up to 30 characters long.  If the field should be used to organize or sort the report,
put a sequence number into the Sort# box.  If more than one field should be included in the
sort (i.e. sort first by Payload and then by Flight), enter the numbers in order by how
important the field is to the ordering of the report.  Figure 4-25 shows the bottom half of the
Report Request page.  Use the scroll bar on the right side of the browser window to reach
these fields.
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FIGURE 4-25  PDL REPORT REQUEST, BOTTOM

For the Layout section, click the button to indicate whether the layout of the report
should be Portrait (narrow side of paper is up as the report is read) or Landscape (wide side
of paper is up).

For Selection Criteria section, click on one or more fields to describe all the possible
combinations of payloads, flights, and increments that can be used to select data for this
report.  If none of these criteria fit the new report, use the Other data entry field to describe
how data should be collected for the report.  Up to 100 characters of description can be
entered.
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Sometimes it is necessary for fields to be summed or to have other calculations
performed against them.  In the Calculation section, if fields should be summed, check the
Summations box and enter the names of the fields to be summed.  If another formula should
be applied to certain fields, check the Other box and enter the fields and the formula to be
used for the calculation.  If no summations or calculations need to be performed, check the
None box.

For the Special Formatting section, if the new report has a required format or is
intended for inclusion in a standardized document, please check the Format for inclusion in a
standard document box.  In addition, include the document number where the format can be
found and the table number within that document that identifies how the new report should be
formatted.  If possible, please fax a copy of the standardized format or table to the PDL Fax
Number: (256) 544-7960.  At the top of the report or in the explanation, please include the
tracking number visible on the Report Request Form.  The tracking number simplifies
matching the fax page to the information entered into the PDL database from the Report
Request form.  Please check the box on the screen if a fax is being sent to PDL.

Any additional information about the report can be entered in the Notes field.  This
field has a maximum length of 1000 characters.

When the fields on the Report Request page have been filled in, click on the Submit
button to send the request to PDL.  Please notice the disclaimer at the bottom of the page.
PDL will make every effort to accommodate the request, but some reports may be restricted
by the data currently being collected in PDL or by limitations imposed by the Oracle database.
Every effort will be made to produce the report as requested.
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APPENDIX A, ABBREVIATIONS AND ACRONYMS

CAD Computer Aided Design
CDH Command and Data Handling
CR Change Request
CSA Canadian Space Agency

DBA Database Administrator

E&OI Engineering and Operations Integration
ECM Electronic Configuration Management
ECO Engineering Change Order
ESA European Space Agency
EVA Extra Vehicular Activity
EVR Extra Vehicular Robotics
EXPRESS EXpedite the PRocessing of Experiments to Space Station

FAQ Frequently Asked Questions
FTP File Transfer Protocol

GUI Graphical User Interface

HOSC Huntsville Operations Support Center
HTTP Hyper Text Transfer Protocol

ICD Interface Control Document
IDD Interface Definition Document
IP Internet Protocol
ISS International Space Station

JSC Johnson Space Center

KSC Kennedy Space Center

MAC Macintosh
MB Megabyte
MHz Megahertz
MRJ MacOS Runtime for Java
MSFC Marshall Space Flight Center

NASA National Aeronautics and Space Administration
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NASDA National Space Development Agency of Japan
NET Network
NT New Technology

OS Operating System

PC Personal/Portable Computer
PCI Payload Configuration Integration
PD Payload Developer
PDL Payload Data Library
POP Payload Operation Performance
PVP Payload Verification Plan

RAM Random Access Memory
RDBMS Relational Database Management System

SQL Standard Query Language
SSP Space Station Program

TCP Transfer Control Protocol
TIM Technical Interchange Meeting

UMDB User Mission Database
URL Uniform Resource Locator

WWW World Wide Web


